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Abstract 

The question of turtle origins is among the oldest and most debated problems in 

vertebrate systematics. A key factor in this debate is the pattern of temporal fenestration in 

the skull, which has long been central to amniote evolutionary hypotheses. Recently, there 

has been robust evidence supporting turtles as having evolved within the diapsid radiation, 

which includes all other living reptiles. This requires that the anapsid skull in turtles is 

secondarily derived. ‘Transitional’ fossils that support this theory were elusive until the 

Middle Permian reptile Eunotosaurus africanus was re-examined using computed 

tomography (CT) in 2015. Eunotosaurus exhibits features that help reconcile the gap 

between turtles and other reptiles, but how it does so is still misunderstood. This 

misconception is attributed to the complexity of the evolutionary concepts involved and a 

need for more intuitive visuals describing the complex architecture of the Eunotosaurus skull. 

This thesis communicates the importance of Eunotosaurus to the study of turtle 

origins through a novel digital reconstruction and a 3D interactive web application. The first 

of its kind, this reconstruction utilizes best practices for restoring a fossil’s antemortem 

shape. It is then implemented in an application focused on contextualizing this taxon in the 

‘tree of life.’ This application provides a valuable learning resource for students and 

investigators as it contributes to virtual paleontology, evolutionary science pedagogy, and 

functional morphology. 
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Introduction 

Where do turtles come from? This is one of the oldest and most debated questions in 

vertebrate evolutionary biology (Cox, 1969; Rieppel & Riesz, 1999; Zardoya & Meyer, 2001; 

Lyson et al. 2010, Lee 2013; Field et al. 2014; Schoch & Sues, 2016, 2019; Lyson & Bever, 

2020). At the center of this conflict is the turtle body plan, which represents an extreme form 

of evolutionary ‘experimentation’ through which we can gauge the potential of 

developmental pathways among reptiles and ourselves. Resolving this mystery would 

provide new insights into the nature, timing, and order of character transformations that 

gave modern turtles their unique anatomy. One morphological area that has long held sway 

in the phylogenetic classification of amniotes (the clade comprising mammals, reptiles, birds, 

their respective lineages, and shared ancestor) is the temporal region of the skull, which 

enjoys a substantial diversity of form across the evolutionary history of this group (Cope, 

1892; Williston, 1917; Werneburg, 2019).  

Turtles exhibit a lack of temporal fenestration, giving them an anapsid skull that 

encases the adductor chamber completely in bone. They have this in common with many 

early (stem) reptiles and crown amniotes (Laurin & Reisz, 1995). Historically, this similarity 

was regarded as the conservation of the ancestral amniote form, assigning turtles as the sole 

survivors of a stem lineage that diverged long before the other crown reptiles (living tuatara, 

snakes, lizards, crocodilians, birds, and their closest fossil relatives) (see Joyce, 2015). 

However, recent morphological and molecular studies reject this hypothesis and conclude 

that turtles evolved within the diapsid radiation – which includes all living reptiles and is 
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broadly defined by a skull with upper and lower temporal fenestrae (Bhullar & Bever, 2009; 

Schaffer et al. 2013; Wang et al. 2013; Bever et al. 2016).  

This would mean that the anapsid skull in turtles is secondarily derived, an ancestral 

callback built around a diapsid evolutionary scaffold (Rieppel & deBragga, 1996). Yet, despite 

the theory of secondary anapsidy enjoying strong genomic support, recognizable 

‘intermediate’ fossils that evidenced this trajectory from diapsid to anapsid remained elusive 

(Field et al. 2014). For years, the most significant stem turtle identified in the fossil record 

was the Late Triassic Proganochelys quenstedti, which had an anapsid skull (Gaffney, 1990). 

Where was this distant turtle relative with a diapsid skull?  

The year 2015 brought two fossils fitting this description (Bever et al. 2015; Schoch 

and Sues, 2015). The oldest and most phylogenetically stem-ward of the two is Eunotosaurus 

africanus Seeley, a 260-million-year-old South African reptile that shares a striking number of 

unique post-cranial features with modern turtles (Gaffney, 1990; Gow, 1997; Li et al. 2008; 

Bever et al. 2015). While it had been discovered in 1892, it was not until 2015 that the 

enigmatic cranial morphology of Eunotosaurus – initially thought to lack an upper temporal 

fenestra (UTF) – was examined using computed tomography (CT) for the first time. This study 

by Dr. Gabriel Bever and colleagues found several cranial similarities with turtles, and most 

importantly, a hidden UTF. This opening was superficially covered by an anterior elongation 

of the supratemporal bone. This, coupled with a recognizable UTF and LTF (diapsid condition) 

in juvenile Eunotosaurus means that the expansion of the supratemporal occurred later in its 

ontogeny or life history. This ontogenetic change could very well explain the eventual 

anapsid condition in more crown-ward turtles, as changes in developmental histories have 
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been known to contribute to major evolutionary novelties in other groups, or taxa 

(McNamara, 2012; Tokita et al. 2013; Haridy et al. 2016). 

To summarize, Eunotosaurus africanus is an organism with both parareptile-like and 

turtle-like features that not only precedes the next fossil turtle relative (Pappochelys) by 20-

million years but also displays a developmental shift in its temporal fenestration. Not only is 

it the diapsid ‘intermediate’ turtle form hypothesized by the genomic data, but its unique life 

history suggests a mechanism by which later turtles could have lost their temporal fenestrae. 

Eunotosaurus exhibits features that help reconcile the gap between turtles and other 

reptiles, but the evolutionary concepts involved in understanding this link can be 

complicated and are often misunderstood.  

 

Interactive Learning in Academia 

Advances in computational and graphic technologies – and the increasing ubiquity of 

their use – have opened the door for a wave of educational and investigative innovations. 

Information-rich multimedia applications support self-managed learning by responding to 

user interaction and leveraging the full spectrum of human processing capabilities, providing 

an alternative to the inefficiencies of rote memorization (Dembo & Seli, 2012). The 

applications in research are also significant: from 3D modeling technology revolutionizing 

how morphological data is collected, analyzed, and disseminated to interactive simulation 

applications dramatically improving surgical planning and medical training (van de Kamp et 

al. 2014; Smith et al. 2016; Sánchez-Margallo et al. 2021; Viglialoro et al. 2021). Overall, 3D 



   
 

 

4 

interactive media are accessible, effective in communicating complex spatial relationships, 

and increase user enjoyment and knowledge retention (Raffan et al. 2017).  

Existing Resources. The last two decades have brought a wave of new efforts 

concerning the teaching of evolutionary biology (Wei et al. 2012). Growing recognition of the 

interrelatedness of evolution in the life sciences has fueled several initiatives. Among them 

are the American Association of Medical Colleges’ Scientific Foundations for Future Physicians 

which establishes evolutionary understanding as a key competency for students in medical 

disciplines, and Vision and Change in Undergraduate Biology Education, a teaching campaign 

backed by the National Science Foundation (NSF), National Institutes of Health (NIH), and the 

American Association for the Advancement of Science (AAAS). Outside of academia, the 

movement to bring scientific literacy to a wider audience has leveraged the digital age to 

produce a wealth of resources and platforms for teaching and learning evolutionary science. 

However, to the average user, much of this knowledge is difficult to attain either because it is 

locked behind a paywall, is intended to be accessed in the context of a lesson plan, and/or 

creates a high cognitive load with long-form text and difficult-to-read diagrams. A table of 

these resources can be found in Appendix A.  

The best interactive online tools dealing with phylogenies and teaching 

macroevolutionary concepts are the Understanding Evolution project 

(https://evolution.berkeley.edu) run by the University of California Museum of Paleontology 

(UCMP) and the Evolution Lab (https://www.pbs.org/wgbh/nova/labs/lab/evolution/) run by 

NOVA Labs and the Biogen Foundation. Both projects do well to introduce tree-thinking, 

though the former is a generalized teaching aid designed for educators and the latter relies 
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on outdated phylogenetic models and a staggeringly large tree diagram without any 

annotations on cladistics. Moreover, none of these digital resources go into detail on current 

findings in turtle phylogeny, much less use 3D morphological data for comparative analysis. 

Teaching Evolutionary Biology. A proper understanding of key evolutionary concepts 

is crucial to appreciating the role that Eunotosaurus plays in the discussion of turtle 

evolutionary history. Furthermore, a foundational understanding of macroevolutionary 

processes and inferences has broad implications for humankind. Consider how animal 

studies implicitly integrate evolutionary thinking by exploiting our shared ancestry with 

model organisms. A key concept in this discipline is tree-thinking, which involves using 

cladograms – also called phylogenetic trees – that depict the evolutionary relationships 

between groups based on common ancestry. 

While it may be expected that any individual who has taken an introductory biology 

course would be familiar with these concepts, research routinely finds that even students 

with extensive secondary-level and collegiate science coursework retain misconceptions and 

deficits in understanding evolution (Alters & Nelson, 2002). This knowledge gap is credited to 

persistent experiential, intuitive, myth-based, or vernacular biases that misappropriate the 

science (González Galli & Meinardi, 2011). Among these misconceptions are a tendency to 

ascribe intentionality to evolution, thinking in terms of evolutionary progress or 

advancement, the idea of “higher” and “lower” organisms, and an overall lack of key tree-

thinking skills (Meir et al. 2007, Novick & Catley, 2007; Young et al. 2013).  

To combat this problem of poor knowledge retention and misinformation, award-

winning evolutionary biologist David A. Baum writes “what is needed are more resources: 
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computer programs, educational strategies, and accessible presentations of current 

phylogenetic knowledge” (2005). Fulfilling this need was the impetus for creating a novel 

interactive web application that not only communicates the findings of Eunotosaurus’ cranial 

morphology in the context of turtle evolution but also clarifies the macroevolutionary 

concepts that underpin this work. 

Didactic Considerations. The workflow for developing the web application design was 

informed by Jesse James Garrett’s Elements of User Experience, onto which the following 

learning theories were applied: 

o Mezirow’s Transformative Learning Theory – provides opportunities for 

identifying, questioning, and revising student assumptions (Mezirow, 1997) 

o Sweller’s Cognitive Load Theory – champions reducing strain on learners’ 

working memory by avoiding information overload (Sweller, 1988) 

o Mayer’s Cognitive Theory of Multimedia Learning – a set of principles for 

optimizing instructional design (Mayer & Moreno, 1998; Mayer, 2005, 2019) 

 

Project Objectives and Scope 

 This project aims to design a 3D (three-dimensional) interactive progressive web 

application (PWA) that will detail and compare the cranial anatomy of Eunotosaurus against 

multiple taxa in their evolutionary contexts, clarify relevant phylogenetic relationships and 

inferences, and review cladistic principles in an interactive learning environment. Overall, this 

will communicate the significance of Eunotosaurus in the phylogenetic story of turtle 

evolution. Current images of Eunotosaurus and the proposed evolutionary change from 
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diapsid to anapsid are limited to static reconstructions found only in scientific literature. They 

do not allow for full detail of the complex cranial anatomy involved and are designed with 

the assumption that a viewer will not project any of the common misconceptions seen in 

students of evolutionary science. Didactic efforts will focus on macroevolutionary patterns 

and phylogenetic inference, as these concepts are not only relevant but also usually under-

represented in evolutionary biology curricula (González Galli & Meinardi, 2011). 

 The development of this application will continue to be an iterative process over the 

long term, and will change as stakeholder input, future user testing, and platform constraints 

come into play. The chosen format, PWA, leverages the speed, native media playback, and 

offline capabilities of a mobile app with the standalone cross-platform functionality of a web 

page. My goal here is to set the stage for further development of the final, functional end-

user product. The scope of this project involves creating the following: 

a) Digital 3D reconstruction of a Eunotosaurus africanus skull for comparative analysis  

b) Design for the overall information architecture of the web application 

c) Prototype of a specific user path that highlights key navigational, didactic, and 

customization functions of the final product 

d) Several 2D reconstructions of fossil and extant representatives of the reptiles being 

compared to Eunotosaurus africanus 

e) A reproducible workflow documenting the user experience and pedagogic principles 

that guided the design of the application, CT data acquisition, and digital 

reconstruction process. 
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Audience 

 The primary audience for this application will be scientific investigators, graduate, and 

undergraduate students who study organismal and evolutionary biology. The secondary 

audience includes hobbyists and lay individuals with interests in turtles, paleontology, 

evolution, and/or systematics. A potential tertiary audience would be educators interested in 

incorporating multimedia science applications into their lesson plans. 

 

Significance 

This project will not only produce a novel reconstruction of a Eunotosaurus africanus 

skull but an innovative approach for teaching and clarifying phylogenetic evolutionary 

hypotheses. Interactive 3D visualizations are a powerful tool for promoting understanding of 

complex ideas and will continue to revolutionize the field of biological communication. This 

application and methods will serve as a model for digital skull reconstructions across multiple 

disciplines, from virtual paleontology to functional morphology and craniofacial surgical 

planning. The user interface design methods will also model the assimilation of pedagogic 

and user experience principles in interactive biocommunication. 
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Methods 

This section provides an overview of two aspects of the project. The first part deals 

with the techniques involved in the novel fossil reconstruction of Eunotosaurus africanus. 

The second covers design principles, didactic considerations, and details of the progressive 

web application. To put it another way, the first part centers on the discovery portion of the 

thesis, and the second part focuses on visual storytelling and interactive learning design. 

 

Part 1. Novel Fossil Skull Reconstruction 

The most influential contribution to evolutionary science comes from the study of 

fossils, which provide dated records of the morphological changes that occurred across 

evolutionary history (Scotland et al. 2003; Schoch & Sues, 2019). However, they are usually 

discovered bearing not only the marks of lifetime trauma and wear, but also post-mortem 

deformation over eons of geological compaction, chemical changes, and tectonism. These 

deformations can include flattening, bending, warping, shearing, erosion, or breakage. 

Reconstructions aim to achieve as close to an antemortem shape as possible to inform 

comparative analyses.  

Several fossil taxa were reconstructed: a 3D skull of Eunotosaurus africanus, and 

seven 2D iconographic representations of relevant taxa including Eunotosaurus, Captorhinus 

aguti, Youngina capensis, Sphenodon punctatus, Mesosuchus browni, Proganochelys 

quenstedti, and Chelydra serpentina. The 2D reconstructions were based on previous work in 

primary sources (detailed later), two-dimensional shear correction from CT data, and 

specimen photography. The novel 3D reconstruction was more complicated, and so had to 
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be broken down into two major stages. The first stage included reorientation of preserved 

bones, addressing deformations, and restoration of bilateral symmetry. The second was the 

extrapolation of missing data and global restoration of smooth contours. The former was 

done first in Cinema4D® (Maxon Computer GmbH), and the latter will be completed in 

ZBrush (Pixologic). 

CT Data Acquisition. A detailed micro-CT scan and volume render of Eunotosaurus 

africanus was provided by the Center for Functional Anatomy and Evolution (FAE), at the 

Johns Hopkins University School of Medicine. While the surface details of the cranial 

anatomy could be observed on the original specimen, there was a limit to how much of the 

surrounding matrix could be extracted without endangering the integrity of the fossil (Fig. 1). 

Since the advent of minimally invasive computed tomography (CT), virtual segmentation and 

reconstruction have become standard practice because it allows investigators to work with 

fossils without harming valuable original materials. 

The specimen (M777) had already been segmented from volumetric CT data using 

Amira®, and each bone was exported as a surface mesh. Initially, the data set was 

compressed and incomplete, so further recovery of surface meshes from Amira® was 

needed. 
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Figure 1a-c. Photographs of the Eunotosaurus africanus specimen, M777. (A) Lateral view, nose 
pointing to the right. (B) Ventral view. (C) Dorsal view. The nose is oriented towards the top in the last 
two photos.  
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Fossil Data Recovery. To accommodate for the older technology that the data and 

Amira® software were natively located on, any bones or meshes that were missing details 

after compression in the provided .STL files were pulled from Amira® in batches. Structures 

that were not in contact, like the nasal and the pterygoid bones, were exported in the same 

.OBJ file for later separation in ZBrush®. This batch method also helped direct the placement 

of bones that were missing in the original data set, as existing bones could be used as 

touchstones for placing new data.  

This process began in Amira®, where the segmentation was completed before this 

project. A surface mesh needed to be generated from the volumetric data for later transfer 

to modeling programs like Cinema4D®. With the segmentation data object already generated 

in the Project Viewer, all that was needed was to right-click the object and Generate Surface. 

This created a new generator module called SurfaceGen. Clicking Apply in the Properties 

panel spawned a surface object titled segmentation.hx.surf. In the button menu, a Surface 

View module was then formed.  

In the initial file setup, Dr. Bever had assigned a different material name to each 

bone. Therefore, the Properties > Material menu could be used to select the desired bone 

surface render. The viewer was cleared of previously selected data points (Properties > 

Action > Clear), and the desired material was loaded in the 3D viewer (Properties > Action > 

Add). Afterward, the Surface View > Extract Surface function generated an Extract Surface 

module. Clicking Apply in the Properties panel created an Extracted Surface object (Fig. 2a). 

This object could be selected and exported under Files > Export Data As > Wavefront (*.obj). 

Once each batch was saved, the Extracted Surface and Extract Surface objects were deleted, 
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the Surface View cleared (Properties > Action > Clear), and a new Material (bone) could be 

chosen for export (Fig. 2b). 

 

 
Figure 2a-b: Amira Workspace. (A) Workspace with generators. (B) Properties manager. 

(A) 

(B) 
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After these bundled .OBJ files were imported in ZBrush®, individual bones were 

isolated by using the SelectLasso tool (CTRL + SHIFT + Drag). Everything captured in the shape 

made by the cursor appeared filled in green. Everything outside the shape was hidden and 

then deleted using the Delete Hidden function (Tools > Geometry > Modify Topology > 

Delete Hidden). This feature was so useful it was added to a custom interface for a more 

efficient workflow. The isolated bone mesh was exported from ZBrush as a separate .OBJ file. 

Using the Undo function, the hidden and deleted mesh could be restored, and the isolation 

process repeated, as necessary.   

The recovered high-fidelity bone mesh was then imported to Cinema4D® (C4D) and 

placed onto the segmented skull by matching the coordinates of the new .OBJ to the original 

bone being replaced. When needed, recovered meshes with a rough surface were 

augmented to desired smoothness with the Polygon Reduction and Subdivisions Surface 

generators (Subdivision Surface > Object Properties > Type = OpenSubdiv Loop, Subdivision 

Editor = 1, Subdivision Renderer = 1). To reduce strain on the graphics card, these generated 

forms were then converted to a single mesh using Object > Current State to Object.  

For bundled meshes that included missing bones, no processing was done in ZBrush®. 

Rather, the .OBJ files were opened in C4D directly and the coordinates of an existing mesh 

were used to guide the placement of the previously missing one. For example, when placing 

the left exoccipital bone, which was missing in the file provided for this project, a mesh 

containing the left and right exoccipital –whose coordinates in space were preserved during 

export from Amira – was placed using the existing right exoccipital as a guide. Then, in Point 



   
 

 

15 

Mode (Modes > Points) the redundant right exoccipital bone was selected (Select > Selection 

Filter > Lasso Selection) and deleted.  

 

Housekeeping  

Cleaning the Mesh. As artifacts and unidentified fragments were removed during the 

rearrangement portion of the restoration, holes were sometimes created in the mesh. To 

patch these holes in the geometry, the mesh selection was changed from Object Mode to 

Polygon Mode (Modes > Polygons) so that the edges of the holes were visible. Normally, the 

workflow for fixing holes is using the Close Polygon Hole (Mesh > Add> Close Polygon Hole) 

function, but the density and irregular topology of the mesh interfered with the calculations 

required for this to work properly. Instead, a Voronoi Fracture object (MoGraph > Voronoi 

Fracture) was added to the Object Manager and made the parent of the mesh being 

repaired. With the Voronoi Fracture object selected and attention turned to the Attributes 

Manager, the default point generator was deleted to avoid fracturing the object (Sources > 

Sources > Point Generator-Distribution > Press ‘Delete’). Then, the holes were closed (Object 

> Object Properties > Optimize and Close Holes). For clarity’s sake, I also unchecked Colorize 

Fragments in the Object Properties tab so the color-coding for textures was preserved. The 

Voronoi Object and optimized mesh were then made into a single object (Object > Current 

State to Object). 

Tracking Changes. Materials were used as a color-coded visual record of the 

retrodeformation process. As new adjustments were made, a new material corresponding to 

the nature of the change would be applied to the object. The order of colored materials in 
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the object manager tags would then provide information on the sequence of changes any 

single element has undergone. In this project, the following color code was established: 

▪ White = No Change 

▪ Pink = Recovered from Amira 

▪ Blue = Original Element in Need of Repositioning 

▪ Yellow = Reflected Across Sagittal Plane 

▪ Red = Repositioned 

▪ Green = Counter-deformed 

▪ Orange = Superimposed 

With each round of changes, the file was saved incrementally so that mistakes or 

missteps could be resolved without loss of information (File > Save Incrementally…). This 

meant that each new save would create a numbered snapshot of the reconstruction. By the 

end of the first stage of this project, there were 80 incremental save files.  

 

Restoration Approach 

With the virtual fossil assembled, the next step of the reconstruction was 

“retrodeformation,” or identifying and reversing the postmortem deformations of the skull 

data (Fig. 3-4). A more specific operation universally used in retrodeformation is restoring 

bilateral symmetry, known as “symmetrization.” Symmetrization is usually undertaken early 

on in vertebrate reconstruction, with the choice of technique often determining the shape of 

the outcome (Ogihara et al. 2006, Gunz et al. 2009). This is because, in the absence of a 

perfectly preserved control, all reconstructions take on a margin of error associated with the 
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infinite possibilities for fragments to move in three-dimensions assumptions about the level 

and nature of deformation. The more heterogeneous the deformation, the more 

interpretation is introduced (Lautenschlager, 2016; Perez-Ramos, 2020). Despite the risk of 

interpretation error, digital restoration can provide great insights into the functional 

morphology of a fossil specimen, invite educational outreach, and lay the groundwork for 

further research (Molnar et al. 2012; van de Kamp et al. 2014). 

To begin, analysis of the deformations in specimen M777 built upon previously 

published work (see Gow, 1997 and Bever et al. 2015) and changed as new observations 

were made along the reconstruction process. Among the distortions noted were: 

▪ Broken skull roof that had been re-adhered with epoxy cement 

▪ Some dorsoventral crushing and torsion across the rostrum, incomplete maxilla and 

mandible, broken right vomer, and twisted pterygopalatine and basicranial complexes 

▪ Dorsally displaced palate (vomer and anterior pterygoid) 

▪ Medially displaced left jugal and missing right jugal 

▪ Damaged facial region with significant loss of nasal information 

▪ Displaced quadrate ramus on the right pterygoid 

▪ Medially displaced right epipterygoid between the prootic and laterosphenoid suture 

▪ Severely damaged exoccipital bones 

The methods used here follow the current standard known as the ‘reflection and 

averaging’ technique: landmarks on preserved structures were reflected across the sagittal 

plane, average position values were calculated against their corresponding reflection, and 

then the original shape was adjusted to the calculated average point. While this approach is 
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not without its faults, namely that it does not fully reverse the effects of profound 

compression, bending, or symmetrical deformation, it is effective (a) when the deformation 

is not severe and (b) in tandem with other restoration methods (Tallman et al. 2014). Given 

the complex distortions and bone loss that specimen M777 had undergone, other methods 

such as superimposition of partially preserved structures, repositioning of disturbed 

fragments, and extrapolation based on morphological constraints also had to be employed in 

the reconstruction process. Moreover, the incomplete and uneven state of preservation 

across each side of the skull called for extensive mirroring of missing components from one 

side to the other. 

  



1 9

F ig u re 3 a -b : A n n o ta te d E u n o to sa u ru s se g m e n ta tio n . M ar ki n gs r efl e ct t h e t a p h o n o mi c d ef or m ati o ns 

fr o m a n (A ) a nt eri or-i nf eri or vi e w a n d ( B ) s u p eri or vi e w. N ot e t h e t wisti n g of t h e s n o ut t h at d e vi at e d 

fr o m t h e mi ds a gitt al pl a n e ( gr e e n d ott e d li n e). Y ell o w li n es a n d hi g hli g ht e d b o n es ar e us e d t o 

c o m p ar e t h e dis pl a c e m e nt of s y m m etri c al str u ct ur es. T h e pr efr o nt al b o n es (li g ht bl u e) a n d m a xill a 

( dar k bl u e) ar e aff e ct e d b y t h e t orsi o n o n t h e s n o ut ( A). B el o w ar e t h e p ost or bit al ( p ur pl e) a n d 

s q u a m os al ( or a n g e) b o n e s w hi c h w er e s hift e d b y as y m m etri c al c o m pr essi o n ( B).

(A )

(B )

R L

R L



2 0

F ig u re 4 a -b : A n n o ta te d E u n o to sa u ru s se g m e n ta tio n c o n tin u e d . M ar ki n gs r efl e ct t h e t a p h o n o mi c 

d ef or m ati o ns fr o m a n (A ) ri g ht l at er al vi e w, a n d (B ) i nf eri or vi e w. N ot e t h e br e a ks t h at di vi d e t h e 

gr e e n a n d y ell o w p eri or bit al r e gi o n ( A) a n d all o w t h e r ostr u m t o b e r ot at e d i nf eri orl y. I n ( B) t h e 

d ef or m ati o ns of t h e pt er y g oi d a n d q u a dr at e b o n es c a n b e a p pr e ci at e d. C o m pr essi o n h as n ot o nl y 

dis pl a c e d t h e e ntir e m asti c at or y a p p ar at us o n o n e si d e b ut c h a n g e d t h e a n gl e b et w e e n t h e pt er y g oi d 

b o n e’s l at er al a n d p ost eri or r a mi. T h e l eft q u a dr at e is als o missi n g a p ost eri or pr oj e cti o n.

(A )

(B )

L R



   
 

 

21 

Stage 1. Assembly and Retrodeformation 

The ‘reflection and averaging’ technique was crucial to the reconstruction and 

underpinned all subsequent efforts of restoring the specimen. An imaginary midsagittal 

plane was placed on the skull and used as a guide for reflecting the bones that were best 

preserved across that plane. For example, much of the left side of the skull roof was either 

destroyed or deformed while the right side was intact, necessitating a mirroring of the 

preserved elements to the left to restore bilateral symmetry. 

Establishing the Sagittal Plane. To determine the midsagittal plane, the basioccipital 

and nasal bones were used as landmarks. This could be done thanks to the lack of lateral 

bending across the snout of the specimen. The axis of the Null object containing all the skull 

bones, which was offset to one side, was set along this imaginary midsagittal plane (Modes > 

Enable Axis or Shortcut L). Once placed, the axis was re-tethered to the mesh (Shortcut L) and 

moved to the 0,0,0 world coordinates in C4D (Tools > Reset PSR). To test this placement of the 

sagittal plane, the bones whose bilateral relationship was least affected by diagenetic factors 

– the articular, angular, surangular, and prearticular bones of the lower jaw – were reflected 

and compared to one another. There had been a shift along the z-axis but the reflections across 

the perpendicular plane were well matched. This would sufficiently serve as a reference point 

for the reconstruction.  

Mirroring. Mirroring, or reflection, is a particularly useful technique when one side of 

the fossil is well-preserved and the other side is not, for example, due to weathering and 

erosion on the exposed side. Moreover, this technique sets up the process of averaging out 

components that have been transformed over time. 
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Elements that had been transformed before reflection needed their Rotation values 

reset to 0,0,0 (Shortcut L > Coordinates Manager > Rotation) for this method to work 

properly, as doing so without zeroing out the Rotation values would yield a reflection across 

the sagittal plane that was off kilter.  

Averaging. Averaging the landmarks of deformed elements is the usual next step 

after mirroring, particularly for structures that are away from the midline. This is because 

deformation can create a significant deviation of these elements from their original position. 

When reflected, corresponding elements can be some distance apart, thus necessitating 

averaging of landmark structure positions to produce a symmetrical reconstruction.  

As each bone was imported to the C4D file, they were all consistently placed in space 

relative to the original data because they all had the same axis. After the establishment of 

the midsagittal plane, the reference axis for every bone was changed to the 0,0,0 position. 

This made mirroring quick and easy, as converting the Scale in the Coordinates Manager 

from positive to negative produced a perfect reflection. For averaging the position of the 

reflected element and its counterpart, the axes were adjusted to a specific landmark by first 

releasing it (Modes > Enable Axis) and manually setting it in the viewer or Coordinates 

Manager. Re-enabling the axis ensured that once it was set the elements could then be 

moved. In Object Mode, the two elements were selected together (hold SHIFT while clicking), 

and C4D’s Coordinates Manager would set the axis of the two objects at the average point 

between their positions. The averaged value was then plugged into the Coordinates Manager 

for each bone, and the reflected element (now re-positioned) could be mirrored again to 

return to its native side of the specimen.  
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 Superimposition. While mirroring was instrumental to replacing the missing or eroded 

elements of the fossil, it was limited by the necessity for a complete source component on 

the well-preserved side to create the reflected counterpart. Fossils can present with uneven 

or distinct states of preservation on either side of the symmetrical plane, with no single 

component fully preserved. In these instances, elements that are incomplete on both sides 

but retain different information can be superimposed to make a single complete element. 

 The need for superimposition was determined with the reflection of a particular 

element to its corresponding side and observing that the preservation was inconsistent. After 

averaging the positions of these bones, rotating to match their planes, determining their fit 

to surrounding anatomy, and considering morphological constraints, the two surface meshes 

would be overlapping to some extent. C4D’s Volume Builder (Volume > Volume Builder) and 

Volume Mesher (Volume > Volume Mesher) generators were then used to remesh the parts 

into a single element (Fig. 6). The Volume Builder needs to be made the child of the Volume 

Mesher and the elements that need to be superimposed must then be made the children of 

the Volume Builder. The resolution of the voxels used to calculate the new mesh can be set 

in the Volume Builder’s Properties Panel (Object Properties > Voxel Size). In this case, the 

voxel size was set between 1.5 – 2 cm. The result is a more complete surface mesh object 

built from the combined volumes of the superimposed parts. This new composite could then 

be mirrored to the other side to maintain bilateral symmetry. Note: if any trimming needed 

to be done to remove extraneous information, any resultant holes in the surface mesh would 

need to be closed (see Housekeeping above) before superimposition can occur, as the 

Volume Builder cannot properly calculate an open mesh. 
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necessary if a break separates large fragments of the same element, superimposition cannot 

be readily done due to lack of overlap, and for articulating elements that have been 

recognizably separated. Because this was done manually, great care was taken to stay as 

anatomically plausible as possible by using a landmark-based approach, keeping the 

morphological constraints, and known relationships with other bones consistent with the 

literature (Gunz et al. 2009). It should be noted that because the articulations in three-

dimensional space can vary, this step does introduce more uncertainty into the restoration 

than reflecting and averaging alone. Even so, this was to be expected with the level of 

deformation in the original data. To allow greater control of the repositioning, the axis of 

each mesh was changed as needed (Shortcut L). This was particularly useful when one point 

of an element was in position, but rotation was still required to move the rest of it into place. 

Moving the axis to the contact point ensured it was not disturbed. 

Plastic Retrodeformation. Taphonomic distortion was another major hurdle in this 

reconstruction. This occurs when elements warp, bend, shear, or stretch without breaking, 

which can have deleterious effects on the useful morphological information retained in the 

fossil (White 2003). This makes it by far the most challenging postmortem change to 

accurately address in reconstructions. Extreme care had to be taken to maintain the integrity 

of important morphological characters. For example, intense observation and attention had 

to be paid during the retrodeformation of the pterygoids, as their intimate sutures with the 

quadrate, prootic, and laterosphenoid bones have significant implications to the relationship 

between Pan-testudines (the clade inclusive of Eunotosaurus and all stem-ward turtles) and 

archosaurs (Bhullar. et al. 2009; Bever et al. 2015). 
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It was apparent from first glance that the ventral elements of the mandible and skull 

would need some manner of plastic retrodeformation beyond what mirroring and averaging 

could accomplish, as the twisting of the snout also extended to the lateral projections of the 

parabasisphenoid, pterygoid, prootic, and basioccipital bones. In other places, such as the 

left pterygoid, there was the matter of counteracting compression forces that acted along 

the length of the bone. While the same approach was taken here to average out the 

positions of corresponding landmarks, simple position transformations would not be enough 

to undo the distortion.  

To address this problem, deformer objects (Create > Deformer) were employed in 

this portion of the reconstruction. Among the most used were the Bend, Twist, and Freeform 

Deformation (FFD) objects. The amount of correction was determined by eye, with results 

checked against existing components and known sutures with other bones. All these 

deformers are independent of the object they are affecting, making them non-destructive 

means of controlling mesh shape.  

Firstly, Bend and Twist deformers were instrumental in correcting the torsion of the 

snout and basicranial region. The paired maxilla and prefrontal bones were more displaced 

than stretched, but midline structures like the nasal, mandibular, premaxillary, vomerine, and 

basicranial components required some amount of counter-twisting to restore bilateral 

symmetry (Fig. 7). This was especially the case for the paired dentary bones in the mandible, 

which had suffered multiple distortions over the millennia (Fig. 8). Because of their 

independence from the mesh, multiple deformers were layered onto the parent mesh to 
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precisely control retrodeformation. Effects could also be double-checked by individually 

toggling each deformer on and off when needed.  

Given that the skull is a fully articulated structure, it was often necessary to apply a 

single deformer across multiple bones that contacted one another. To do this, the desired 

meshes were selected and dropped into a Null Object (Create > Null). Then a chosen 

deformer was made a child of that Null object, allowing all the child meshes to be 

manipulated together, reflecting the ripple effects of applied forces across intimately 

connected bones.  

  

(A) 
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After correcting the twist in the midline structures came the issue of undoing the 

effects of compression. This was by far the most complex portion of the reconstruction, as 

the affected structures – namely the pterygopalatine, pterygoquadrate, and masticatory 

apparatus – shared multiple sutures with numerous bones. Because of the many articulation 

points of these cascades, displacement along the lengthwise axis had consequences for all 

surrounding elements. This was made apparent through the pterygoid bones, which could 

not be mirrored, displaced, or otherwise manipulated in a manner that would restore 

bilateral symmetry. The left side was compressed along its entire length. The right side was 

unevenly stretched and broken from the torsion that affected the snout. Moreover, the left 

masticatory apparatus was compressed such that the quadrate was rotated superiorly and 

the right pterygoquadrate was pushed outward such that it was disarticulated from the right 

prootic (Fig. 10a). 

For this, the answer was FFD, or Freeform Deformation, which creates a grid-like 

scaffold that can be fitted to the bounds of a given mesh object (Object Manager > FFD 

Generator > Properties Manager > Object > Fit to Parent). When the FFD is made the child of 

an object, each point along the generated cube lattice corresponds to a parameterized 

portion of the parent object (Fig. 9). These points can be manipulated in Point Mode (Modes 

> Points). Any deformations to the lattice structure create associated changes to the parent 

mesh, regardless of its complexity or point density. Moreover, the ability to reset this 

deformer allowed revisions to be made as new information came in or fresh eyes were laid 

on the model. 
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Still, this deformer was used sparingly as its capacity to preserve volume was limited. 

In cases where the deformation was consistent throughout the element, or the FFD would 

otherwise be too complicated to apply, the Bend and Twist deformers were preferred. Every 

time the Bend deformer was used, it was adjusted to preserve the volume of the parent 

object (Bend Object > Properties Manager > Object > Keep Length). 
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Extrapolation. While the previously mentioned methods can do a lot to restore useful 

morphological information from fossil data, there are times when no amount of reflecting, 

duplicating, or other means of exploiting bilateral symmetry can recover the missing original 

form. In those cases, extrapolation is the last recourse. Often this is done by using other 

specimens – either of the same species or a close relative – as reference for 

retrodeformation or estimating missing parts. This could not be done here, however, as like 

with other paleontological work, this specimen represents the most complete adult 

Eunotosaurus skull in the fossil record. Even if another specimen was available, the potential 

for interspecific variation, sexual dimorphism, or the age of the specimen to introduce more 

error is too high. The only available options were to compare across distantly related taxa 

stem-ward and crown-ward in evolutionary time to extrapolate the variability that could 

exist. This approach, while not perfect, meets the needs of creating a workable model for 

biomechanical analysis. This was helped by the fact that the extrapolated changes in 

question – such as correcting the displacement of the palate and introducing a bend– held 

little phylogenetic signaling value (Fig. 12).  

In all cases where extrapolation had to be used it was paramount to maintain known 

sutural contacts, assess morphological constraints, and preserve the volume of the mesh. 

When deciding what alterations could fall within the biological potential of the specimen, the 

chief references used were papers describing the cranial morphology of other turtle relatives 

(Fig. 11) like Proganochelys quenstedti and Pappochelys, and descriptions of various 

Euntosaurus specimens (Cope, 1892; Gow, 1997; Bever et al. 2015; Schoch & Sues, 2017).  
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Figure 11: Comparison of Sagitally Sectioned Skulls. Figure from Gaffney (1990). Shown from top to 
bottom are Captorhinus, Proganochelys, and Chelydra. Images such as these were used in tandem 
with written morphological findings to extrapolate the palatal deformation needed to restore its 
anterior contact with the premaxillae, seen in Figure 11. Text not meant to be read. 
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Part 2. User-Centered Design Framework 

The next step in this project was to build a web application that would house and 

contextualize the reconstructed Eunotosaurus skull. 

In the user experience (UX) industry, few books have had as wide an impact as Jesse 

James Garrett’s Elements of User Experience (2010). In it, he organizes the foundational 

principles of UX design into a five-plane framework: strategy, scope, structure, skeleton, and 

surface. Each plane, or tier, sets the stage for the next, with early goal setting and planning 

(abstract) informing the structure and content of the final product (concrete). The end-user 

experience reflects every decision made along each plane of this framework. 

Moreover, the entire framework can be further subdivided into two approaches. 

Depending on the vision for a given interactive product, one can look at issues that arise as a 

functional problem or an information dissemination problem. These approaches hinge on the 

purpose of a given system as either a platform for functionality, an information resource, or 

– more commonly – a mix of both. The functional approach is concerned with tasks, which 

not only encompass the steps of a given procedure but also how users think through them. 

The informational approach is concerned with meaning, which entails helping users to find 

and understand the information provided. The guiding principles behind this application 

balance the two approaches.  

The Strategy encompasses the overall objective of the application, incorporating the 

user’s needs and creator’s goals for the final product. The Scope encompasses the specific 

functions, features, and content that will deliver on the project’s strategic goals, defined here 

through enabling objectives. The Structure determines how these functions are organized, 
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mapped in the information architecture, and defined through the interaction design of the 

application. The Skeleton plane is a concrete expression of the more abstract structural 

concerns of the UX design. It takes the form of prototypes that are designed to facilitate 

understanding, define key user interface (UI) elements, and arrange navigational 

components for maximum efficiency and impact. This is where the point of contact between 

the user and the system takes shape. Overlying all of these is the Surface plane which 

comprises the finalized interactive application. This is where visual design elements tie the 

entire conceptual framework into a functional end-user experience. In all, this workflow 

builds from a conceptual foundation to increasingly specific functional and sensory design 

work (Fig. 13a). 

It should be noted that thinking of these planes as discrete steps that are set in stone 

once completed can result in a stilted product (Fig. 13b). Decisions made at each phase 

naturally define and restrict the available options further up the framework, but sometimes 

implementing an idea can reveal the need to go back to the drawing board. As such, the 

workflow should be adaptable and deliberate. Changes will come as new information is 

attained and prior decisions are revised accordingly.   
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Strategy: Objectives and User Needs 

 It was important to establish a shared communication goal with Dr. Bever. The 

motivations behind this novel reconstruction and web application were to not only provide a 

visual resource for cranial support of a Eunotosaurus – turtle clade but to do so in a manner 

that tackled common intuitive biases and misunderstandings.  

 Overall Objective. This application will accessibly communicate the morphological and 

phylogenetic insights Eunotosaurus africanus contributes to the still-debated question of 

turtle origins. It was determined that the primary users are investigators, graduate, and 

undergraduate students of evolutionary biology and paleontology. Once these core aspects 

of the application strategy were defined, the work of validating the approach and conducting 

the research could begin. 

Research and Identified User Needs. At the start, preliminary research was carried out 

to contextualize the existing communication challenges and identify user needs. This initial 

phase of research covered the following: 

Information-Oriented Exploration 

▪ Web search for key terms: Eunotosaurus africanus, early turtle relatives, turtle 

evolution, learn evolution, evolution misconceptions, reading cladograms, and others 

▪ Existing learner resources: online learning modules like the NOVA Evolution Lab, 

images, videos, and science news articles 

▪ Existing teacher resources: online lesson plans, educational primers, pedagogic 

content, design guides, and primary literature on science education  

▪ Relevant existing interactive resources: anatomical model viewers, learning apps 
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▪ Reviewing knowledge gaps and information needs from the educator perspective 

▪ Review of the existing body of scientific literature on E. africanus to identify the core 

concepts in the story that need communicating 

Function-Oriented Exploration 

▪ Review of basic user interface design principles, navigation, and conventions 

▪ Market research on web application layouts 

▪ Informal stakeholder interviews 

Key Research Findings. The first round of research focused on identifying any 

resources that touched on the same ideas as this novel application. Several assets for 

teaching, informing the public, and fighting misconceptions about evolutionary science were 

identified throughout this phase of development. Among these were educator references for 

building lesson plans, scientific articles, short videos, and interactive web tools aimed at a lay 

audience. Again, a table of these resources can be found in Appendix B. While there is plenty 

of information online, some major problems were quickly apparent: information overload, 

difficulty in separating trustworthy sources from misinformation, and high saturation of 

educator-focused materials over student-facing ones. Moreover, no online resources outside 

of primary literature specifically covered turtle phylogeny or discussed cranial evidence of a 

Eunotosaurus– turtle clade. In all, this preliminary work confirmed the dearth of web-based 

applications focused on demystifying phylogenetic concepts or communicating new data in 

turtle systematics. 

To help inform the content curation and design process, there was also a need to 

identify the major obstacles to communicating phylogenetic research. It would be difficult, 
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for example, to try and convey how Eunotosaurus adds to our understanding of evolutionary 

byproducts, or exaptations – traits that served one function and were then co-opted to serve 

another – if they believe evolution is a purpose-driven, teleological process. Among the 

greatest obstacles to learning evolutionary biology, even among academics, is the 

persistence of intuitive biases and value judgments on scientific understanding. Some of the 

most common preconceptions are: 

▪ Vernacular misconceptions, which arise from words having disparate meanings in a 

scientific context and everyday use. Examples include seeing evolution as “only” a 

theory or using fitness to describe a given individual’s vitality and health rather than 

reproductive success (Alters & Nelson, 2002). The adjustment for this is to include 

plain-language descriptions of these terms and make definitions easily accessible. 

▪ Reductionist biases that atomize organisms into discreet traits which have been 

optimally forged by natural selection to fulfill their purpose. This view considers an 

organism’s traits as a function of being “for” a specific purpose, rather than the result 

of the circumstances that caused it to arise (Gould & Lewontin, 1979). This mode of 

thought makes prescriptions about a trait existing to meet a need or fulfill the 

“intentions” of an external force… forgetting that traits can be developmental or 

physiological byproducts or be non-adaptive altogether. Counteracting this requires 

acknowledging the role that multiple factors play in an organism’s morphology – be 

they genetic, developmental, or phylogenetic – and avoiding the use of design-

oriented terms in pedagogy. Additionally, the conceptualization of phylogenetics 

(shared ancestry) helps by placing morphology in a broader historical context. 
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▪ Progressionist notions of evolution as a linear process that gradually produces 

“higher” or more “advanced” forms. These ideas often underlie further 

misconceptions that see evolutionary change as following a “mainline” leading to a 

distinct endpoint (usually humans) and all other species as derivative of “sidetracks” 

along that main lineage (O’Hara 1992). These biases can be disrupted by rotating 

nodes on a tree diagram to avoid a ladder-like appearance, particularly ones that 

contain humans as a terminal taxon. 

▪ Mistaking sister taxa for ancestors. This misconception is quite common, often taking 

the form of the question “If we humans descended from chimps, why are there still 

chimps?” The reality is that while chimps and humans share a recent common 

ancestor, this ancestor was neither chimp nor human. The misconception stems from 

a mistaken idea that speciation is a process by which one entire species gradually 

morphs into another, or “anagenesis” (Gregory, 2008). The answer is to stress the 

existence of common ancestry from which species diverge, rather than emerge. 

Rotating nodes in a tree can interrupt linear thinking in this intuitive bias. 

▪ Biases of common reading convention that cause observers to glean several incorrect 

things about a phylogenetic tree, or cladogram (Meir et al. 2007; Gregory, 2008): 

o That taxa at the far right on a tree represent the more “advanced” groups, or 

conversely, that the outgroup taxon on the far left is more “basal” or similar 

to the root ancestor of all others on the tree. While the structure of certain 

trees may appear to coincide with this reading, assuming so is fallacious, 

especially when the terminal taxa on a tree are all extant or living. All living 
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taxa that share common ancestry have been evolving for just as long as one 

another. This thinking can also be disrupted by rotating the nodes of a tree, as 

well as explicitly recognizing that any given cladogram represents an 

incomplete sample of life to communicate only relationships. 

o That a long branch on a phylogeny indicates a lineage that has changed very 

little over time. This can be combatted by either signaling towards the true 

diversity of a given terminal taxon or adding more representatives to 

“balance” the tree out. 

o A tendency to read relatedness between taxa by “counting nodes,” or judging 

their physical distance in the diagram. As a reading error, this can be 

addressed by clearly signaling how grouping works in the diagram. 

While this list is by no means exhaustive, it does provide a solid foundation for guiding 

the subsequent phases of development, particularly in terms of information dissemination. It 

could also be revisited whenever needed throughout the design process as new questions of 

pedagogic concern arose. From this grasp of the barriers to understanding, the content 

curation and design could take shape.  
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Scope: Content Curation and Functional Specifications 

The Scope plane translates the overall objective into specific requirements for 

functionality and content. Defining these requirements is key to an efficient workflow, as 

new ideas often come up throughout the iterative process. Being able to compare them 

against these baselines helps in evaluating whether ideas fit into the project’s end goals. This 

also extends to ideas that cannot be executed within the deadline but can form the basis of 

the next milestone in future development. In this methodology, defining the requirements 

begins with enabling objectives.  

Enabling Objectives. Enabling objectives are supporting players in the execution of 

the overall goal of the application. They inform the functional and content requirements of 

the app by breaking down the broader main objective into specific goals. Goals to bridge the 

major knowledge gaps identified in the research phase (see Key Research Findings) and a list 

of the key tasks for carrying them out was organized into Table 1.  

User Personas. User personas are archetypal representations of the user population. 

They serve as touchstones for building empathy towards user perspectives, facilitating 

discussion with stakeholders, and anticipating user needs throughout the design process. In 

all, they are useful for defining the scope of the project and prioritizing features. Each 

persona consists of a name and photo, key demographics, their frustrations (or “pain 

points”), a quote that encompasses their personality, and their goals.  

The name and photo (downloaded copyright-free from Unsplash.com) help in 

reinforcing empathy for the personas, with key demographics used to cover the range of 

potential users and inform their needs. Frustrations and personality cues help structure later 
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information and surface design. These personas were based on preliminary research, input 

from stakeholders and educators, personal experience with teaching evolutionary biology to 

post-secondary students, and observation of hobbyist circles in the paleobiology community. 

All personas can be viewed in Appendix C.  

Content and Functional Specifications. Following the preliminary research data, user 

persona data, and stakeholders like Dr. Bever, the content requirements for the project were 

defined. Among them was a directive to make terminology accessible through plain-language 

text and linked definitions. Moreover, there was careful consideration for word usage, 

necessitating multiple rounds of stakeholder feedback on text alone. This is because 

incautious use of terminology has, in the past, reinforced vernacular misconceptions about 

evolutionary processes (Schoerning, 2014). Another specification was deciding that while 

evolutionary biology represents a vast discipline, the contents in the application would focus 

on macroevolution and tree-thinking only. This would keep the focus on the big-picture of 

turtle phylogeny and address the most neglected and misunderstood facets of evolution 

pedagogy.  

Functionally, a few things were deemed important. First was the ability for users to 

observe three-dimensional skull data and isolate bones, as it would allow for close 

observation of landmarks and features. This would set up understanding and appreciation for 

the host of characters used in comparative analysis. Next on the list of functions was the 

ability for users to interact with a cladogram. In the teaching of cladistics, five core tree-

thinking skills have been named (1) identifying characters (or synapomorphies), (2) knowing 

which taxa on a tree exhibit or do not exhibit a character, (3) understanding clades as a 
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concept, (4) evaluating relatedness of groups in a tree, and (5) using deductive reasoning 

based on most recent common ancestry (Novick & Catley, 2013). While most college 

students with some background in biology have enough knowledge to reason through skills 

1-2, they lack skills 3 and 4, which deal with diagram structure. Therefore, users need to be 

able to affect and observe the structure of the cladogram, be it to rotate nodes or expand 

the available information. 

With these content and function requirements in mind, the Key Tasks identified 

earlier could be translated into features for the final product (Table 2). These specifications, 

while prone to change as design constraints were introduced, allowed the project to move in 

a more concrete direction. 
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Users will be able to… Key Tasks 

Understand why Eunotosaurus is 
considered a stem turtle 

▪ Observe the cranial sutures and 
structures that support a turtle 
affinity for Eunotosaurus 

▪ Know post-cranial evidence for a 
Eunotosaurus-turtle clade 

▪ Distinguish between the crown, stem, 
and total clades 

Understand how comparative morphology 
can inform evolutionary relationships 

▪ Make detailed observations of cranial 
morphology  

▪ Make comparative inferences based 
on ancestral, recent, or unique traits 

▪ Use evidence of most recent 
common ancestry to make inferences 

Understand how Eunotosaurus, a stem 
turtle, adds to our knowledge of crown-
ward turtle evolution 

▪ Understand how fossils let us make 
inferences about the past relating to 
modern species 

▪ Distinguish between the crown, stem, 
and total clades 

▪ Understand relative relatedness of 
taxa in a tree 

▪ Use evidence of most recent 
common ancestry to make inferences  

▪ Learn about the contribution of 
Eunotosarus to turtle origins 

Recognize their current knowledge gaps in 
evolutionary biology, if any 

▪ Reflect on their intuitive biases 
surrounding evolution 

▪ Be able to rotate nodes in an 
interactive tree diagram 

▪ Be able to add taxa onto an 
unbalanced tree diagram 

▪ Review terminology that they may be 
misinterpreting 

Table 1. Summary of enabling objectives and key tasks for those objectives. 
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Users will be able to… Associated App Features 

Understand why Eunotosaurus is 
considered a stem turtle 

Morphology:  

▪ Comparative Morphology Tab 

▪ Taxon Overview 

Phylogeny:  

▪ Information Panel 

Resources:  

▪ Discussion 

Understand how comparative morphology 
can inform evolutionary relationships 

Morphology:  

▪ Comparative Morphology Tab 

▪ Mini Cladogram 

Phylogeny:  

▪ Interactive Cladogram 

▪ Appearance > Filter by Major Trait 

▪  Fundamentals > Phylogenies and 
Deductive Reasoning 

Understand how Eunotosaurus, a stem 
turtle, adds to our knowledge of crown-
ward turtle evolution 

Phylogeny:  

▪ Information Panel 

▪ Fundamentals > Crown vs. Stem 

▪ Fundamentals > Form and Function in 
Phylogeny 

Resources:  

▪ Discussion 

Recognize their current knowledge gaps in 
evolutionary biology, if any 

Phylogeny:  

▪ Fundamentals 

▪ Information Panel 

▪ Terminology Links 

Resources:  

▪ Discussion 

Table 2. Summary of enabling objectives and associated app features. 

  



   
 

 

51 

Structure: Information Architecture  

 The Structure plane defines the activities, interactions, and information that the user 

will navigate. Where the Scope defines requirements, the Structure tangibly influences the 

final product. Part of this is outlining an information architecture, a flexible structure that 

organizes the components of the application and how users can move through it efficiently 

and effectively. Tied into the information architecture is interaction design, which anticipates 

user queries and behaviors, then designates how the system will accommodate them. 

Information Architecture. The information architecture is expressed through 

flowcharts, which organize the component features and content into a navigable framework. 

The program used to put together the first iteration of a flowchart, found in Appendix D, was 

the draw.io webtool (https://app.diagrams.net). The polished version was created using 

Lucidchart (Fig. 33). 

As described in Table 1, three major parts of the application were planned to help 

address the enabling objectives: Morphology, Phylogeny, and Resources. The Morphology 

houses the 3D models of Eunotosaurus and other taxa, allowing users to not only appreciate 

the intricate cranial anatomy that supports a Eunotosaurus-turtle clade but compare how the 

bony relationships change across taxa. 3D models were chosen because cranial bone 

relationships are so complex that a familiarity with the architecture in space is usually 

needed to fully understand 2D representations. This is why it is the first module users 

encounter. Next is the Phylogeny section. It places Eunotosaurus within its most-relevant 

evolutionary context, visually tells the story of secondary anapsidy in turtles, and serves as a 

platform through which users can brush up on their phylogenetic knowledge. Lastly, the 
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Resources section ties the interactive experiences from the previous sections into concise 

didactic material. It contains two subheadings: Articles and Appendix. In Articles, users can 

access multimedia learning modules related to turtle evolution and Eunotosaurus. The 

Appendix holds additional information that more knowledgeable users will be interested in, 

such as the character matrix used to create the Phylogeny section’s cladogram and a link to 

Dr. Bever’s lab website.  

Initially, the information architecture chart was made to act as a point for discussion 

with Dr. Bever and stakeholders regarding information hierarchy and functions that would 

meet the enabling objectives. For example, users might still need help connecting the dots 

between the distinct morphological and cladistic information found in the first two sections, 

so the Articles tab – which summarizes the major takeaways – was prioritized as the landing 

page for the Resources section. Where the information architecture organizes content, the 

functions that support it are defined by the interaction design.  

Interaction Design. Together with the informational components of this design comes 

the functional element of the Structure plane, known as interface design. This is the axis 

upon which the rest of the UI design process revolves. It is the dialogue between the user 

and the product or service. In other words, it is how the user will communicate with the 

system and how the system will respond. This dialogue was expressed in four domains: 

▪ Words. The word choice in the interactive components, like button labels, needed to 

be at once clear, meaningful, and effective. The goal is to impart as much information 

as possible without overwhelming or confusing the user. For example, ambiguous 

language such as a simple “More” to describe the entire supplementary information 
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section for the application warranted stakeholder input and consultation with a 

thesaurus. This tab was then renamed “Resources.” In the same vein is the capacity 

for designers to miscalculate the meaning users will take away from a label. Initially, 

the “Articles” subheading was called “Modules” to reflect the presence of organized 

educational content, but stakeholders expressed concerns about the term having too 

many definitions to be clear, as well as a negative emotional association with 

standardized testing. 

▪ Visual representations. This covers the use of images, graphics, typography, and icons 

that convey meaning or help in user navigation. Part of the interaction considerations 

here was to ensure ease of use. Simple, intuitive design language such as using radio 

buttons that denote mutually exclusive selections (as opposed to checkboxes, which 

users associate with enabling multiple selections) set expectations for what an 

interaction entails. Typography was also used to impart meaning, with type 

conventions such as underlined blue text to signal the presence of a link. This is also 

where visual feedback comes into play (see Navigation Design for an example). 

▪ Space. This aspect of interaction design exploits the human tendency to think in 

terms of physical space, not just the devices they use to access digital systems. In 

practice, this means a few things: keeping physical metaphors in mind (think about 

how modern systems utilize them; there is a desktop, folders, a trash bin, and 

windows, to name a few), exploiting user skills for physical interaction with objects, 

and – more mundanely – device capabilities.  
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Incorporating a 3D model that users can manipulate through intuitive mouse or 

touch-based gestures was the first idea to meet this consideration. Beyond that were 

the decisions to include an interactable cladogram designed to be explored, rather 

than creating an animation that would deliver the same information. The choice to 

add visible nodes, turn them into buttons and make their dimensions touch-friendly 

were all functional design choices relating to the information-dissemination goals 

outlined earlier. 

▪ Time. This relates to media on a time axis, such as music or video. Another way to 

look at it is how the user may want to spend their time. For those who want to 

achieve a thorough understanding, the first two sections (Morphology and 

Phylogeny) provide a rich didactic landscape for exploration and discovery. For those 

who want to cut to the chase, the Resources portion provides clear, informative 

articles and videos that synthesize the background and supporting information they 

need to understand the ‘Eunotosaurus hypothesis’ (see Joyce et al. 2015). 
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Skeleton: Interface, Information Design, and Navigation 

 The Skeleton plane is all about creating a user-friendly layout that enables the easy 

completion of desired tasks. Whereas the structure concerned itself with the broader 

architectural and interactive components, this plane refines the level of detail.  

The Skeleton is defined through the interface, navigation, and information designs. 

The interface design connects users to the system’s various functions. The navigation design 

allows the user to see and move through the system’s Structure. The information design 

draws on and incorporates the other two elements to communicate ideas to the user. 

Prototypes bring these three parts of the skeleton together in a cohesive reference for the 

final product’s visual polish. 

Interface Design. Creating a serviceable interface design is about selecting the right 

elements for the task at hand. While deciding which functions appear on a given screen falls 

within the plane of Structure, how they are realized and refined is the bread and butter of 

interface design. For example, it was determined early on in prototyping that a dropdown 

menu should be placed in the Morphology screen. While the first interaction a user would 

attempt when given a 3D model viewer is to click on the model itself, a list would also allow 

users to see their options before committing to a selection. A dropdown is the only space-

saving medium for including the total list of bones and bony landmarks available. However, 

the execution of that dropdown menu was the subject of much debate. In the end, the desire 

to reduce cognitive strain led to the adoption of a standard menu with a hover effect over a 

multi-level dropdown with subheadings (Fig. 14). This back-and-forth between functional 

requirements and user-friendliness was a constant throughout the iterative process. 
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Navigation Design. Navigation design allows users to get around within the system. 

Therefore, it must accomplish the following: 

1) Provide the means to get from point A to point B on the site or application. 

2) Communicate the relationship between the elements on each page. 

3) Orient the user to the relationship between the contents of the navigation 

and the page the user is currently viewing. 

The first was achieved through incorporating a persistent global navigation bar that 

linked to all the major sections of the application. To orient the user to which section they 

are currently viewing, the sharp contrast between a near-black background and white text is 

used as a modern take on the button press metaphor (Fig. 15). This is an example of how 

feedback supports navigation and interaction design.  

At each section, local navigation provided users with access to “nearby” functions 

related to the available tasks. On this same page, the lower local navigation bar is colored 

using a light blue that was consistently used throughout the application for local navigation 

components. When an option is selected, it too uses a ‘pressed button’ design to orient the 

user to their last action. 

Contextual navigation – which was incorporated into the content itself – took the 

form of in-text hyperlinks and “See Also” links that allow users to clarify unfamiliar or 

confusing vocabulary and draw associations between concepts. Here, the contextual 

navigation also includes the use of instructional color and changes in line weight to help the 

user keep track of their place in the cladogram and impart meaning. 

 



5 8

F ig u re 1 5 . A n n o ta te d n a v ig a tio n a l d e sig n in th e P h y lo g e n y se c tio n . Hi g hli g ht e d ar e t h e gl o b al 
n a vi g ati o n b ar ( y ell o w), t h e l o c al n a vi g ati o n b ar ( or a n g e), t h e i nf or m ati o n p a n el f ull of c o nt e xt u al 
h y p erli n ks f or k e y t er mi n ol o g y ( gr e e n). In bl u e is t h e cl a d o gr a m its elf, w hi c h is m e a nt t o ori e nt t h e 
vi e w er a cr oss t h e di a gr a m a n d us es i nstr u cti o n al c ol or a n d s h a p es t o m a k e c o n n e cti o ns b et w e e n t h e 
t e xt’s s u b h e a di n gs a n d t h e di a gr a m. T e xt n ot i nt e n d e d t o b e r e a d.

In fo rm a tio n D e sig n . I nf or m ati o n d esi g n i n c or p or at es t h e t w o pr e vi o usl y dis c uss e d

el e m e nts t o o pti mi z e t h e pr es e nt ati o n of i nf or m ati o n t o t h e us er. It i n v ol v es n ot o nl y 

d e ci di n g o n t h e vis u als t h at will a c c o m p a n y t h e t e xt a n d i m p art m e a ni n g b ut als o c ur ati n g 

t h e w a y i nf or m ati o n is gr o u p e d. Gi v e n t h e pr oj e ct ai m f or t his s yst e m as a di d a cti c t o ol, t his 

w as b y f ar t h e m ost i m p ort a nt d esi g n c o m p o n e nt t o t h e s u c c ess of t h e a p pli c ati o n. T his w as 

t h e d o m ai n t hr o u g h w hi c h t h e mis c o n c e pti o ns a n d p e da g o gi c c h all e n g es i d e ntifi e d e arli er 

n e e d e d t o b e a d dr ess e d.
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Because the interpretation of phylogenetic trees is central to the way evolutionary 

relationships are interpreted and discussed, and many intuitive biases that form around 

them are visually related, the Phylogeny section’s cladogram required considerable time and 

effort to design (Fig. 16-18) (Dees, 2014; Novick & Catley, 2012). The following design 

choices were made to reduce potential misinterpretation of the phylogenetic tree:  

o Adding an Info button that alerts users not only to the specific purposes of a 

cladogram but links to a primer module, “Cladograms 101.” 

o Adding dots at the nodes and ends of the tree to signify that the elements are 

interactable, draw a visual parallel between the end taxa and the nodes which 

represent common ancestors (unknown taxa whose evolutionary divergence 

yielded the ancestral species beyond that point in the tree), and reaffirming 

the importance of nodes in the interpretation of a phylogeny (Catley, 2006) 

o The vertical line style of the phylogenetic tree was chosen because the 

horizontal splitting at the nodes fights the intuitive bias that there is an 

evolutionary “mainline,” like a long diagonal backbone may suggest (Novick et 

al. 2007, 2010, 2012) 

o Including as much plain language as possible and adding clarifying links to 

important terms (Schoerning 2014) 

o Tree loads with already-rotated nodes and group of interest not on the far 

right to avoid a “ladderized” appearance, which discourages intuitive notions 

of evolutionary progress or advancement (Meir et al. 2007; Gregory, 2008) 
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o The user is given the option to expand the branches to give a more complete 

view of the diversity within, dispelling the perception that the groups outside 

of the taxon of interest are not as complex (Catley, 2008) 

o When a node is selected, labels appear that explicitly name the groups 

terminal taxa to represent, as not all are the sole representative of their 

clades like Eunotosaurus (Sweller 1988) 

o Option to add taxa like synapsids and mammals to the tree as an amniote 

outgroup, simultaneously fighting notions of mammalian forms as “higher” 

and the assignment of outgroups as more “basal” or “primitive.” Note: this 

could not be fully addressed because of constraints on the size of skulls for 

use in morphological analysis, but future development plans include an open 

workspace that can be zoomed into and out of that will address the issue of 

an unbalanced phylogenetic tree. 

Though this was not the only area where information design was applied, the 

cladogram provides the most robust example of its use in this methodology. Other decisions 

of information design included how topics were to be grouped, how much information to 

display – in this case, it was making the tradeoff between a more complete tree and having 

skull figures large enough for the user to appreciate the differences between taxa. 
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Surface: Visual Design 

Design Principles. The surface design for this application focused on four major principles: 

Consistency, Discoverability, Feedback, and Accessibility.  

Consistency. The Consistency principle leverages the human tendency to find and adhere 

to patterns. In practice, this means limiting the number of ways actions and elements are 

represented so users do not have to learn new representations for each task they want to 

complete. One avenue for consistency is visual design, for which a style guide is often used 

(Appendix E). One way to achieve unity in design is through instructional or meaningful color. 

For example, elements of the application that allow users to associate or interpret didactic 

content were colored royal blue. Likewise, explanatory text is accompanied by an 

unsaturated sandy yellow color, and highlights isolating bony structures are in goldenrod. 

This visual consistency not only reduces cognitive load and increases predictability but allows 

for meaning to be applied when elements break that consistency. Outside of serving as a 

reference to the colloquial phrase ‘tree of life,’ this was the reason for using green on the 

nodes of the phylogenetic tree diagram. 

It is not just internal consistency that is useful, however. External consistency entails 

using well-established conventions of user interface design in each system. According to 

Jakob’s Law of Internet User Experience, users spend most of their time on sites other than 

yours and will bring their expectations from previous experience to your system. As such, it is 

imperative to design patterns to which users are accustomed. This application does so in 

multiple cases, from the use of “ⓘ” for pop-ups that provide additional information, to using 

carrot symbols for dropdown menus (Fig. 19). Layout elements are also borrowed from 



   
 

 

65 

conventional design practices, such as placing search bars and exit buttons at the top right, 

and nesting titles and back buttons on the top left. These elements come together to make a 

product that meets user expectations. 

Discoverability. The Discoverability principle ensures users can see everything they 

need to accomplish a task without redundant or extraneous information. This can be 

inverted to remind designers that components that are hidden or hard to see will be under-

utilized. Designing for discoverability takes many forms. It can refer to the establishment of 

visual hierarchy with font weights, color contrast, and size of elements cueing the user onto 

what is important in each page. The use of multiple tools for establishing hierarchy is used in 

the Morphology section, which leverages the stark contrast between the off-white bone 

model and the dark background of the 3D viewer. A second method for establishing 

hierarchy was the use of drop shadows which place the local navigational content as more 

important than the appearance tools on the bottom left of the 3D viewer (Fig. 19).  

Another way to design for discoverability is through affordances or visual cues that 

signal an element’s capabilities. A physical example of this would be the inclusion of a metal 

plate at doorknob height for doors that need to be pushed. The visual design of this app, 

translated to the inclusion of scroll bars whenever possible and cutting off certain elements, 

such as text or buttons, within a given window to let the user know that they can scroll to see 

more. Hover effects are another form of affordance, letting users know that an element is 

interactable. The inclusion of distinct internal and terminal nodes in the cladogram was 

another affordance added to the design, serving both an interactive element for users to 
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afford working with the tree through its nodes, and to reinforce node-based cladistic 

analysis.  

Feedback. Where discoverability cues users to how they can interact, what happens once 

they do so is where feedback comes into play. This facet of visual design is directly tied to the 

interaction and navigation design by providing cues to the user about what action has been 

taken, what they have accomplished by it, and what their options are for the next steps. It 

was previously noted that the use of a spatial metaphor for a pressed button (by darkening 

the background of a selection) was the visual cue for global and local navigation. Another 

example is the change in dot size and color when Landmarks are selected in the Morphology 

section (Fig. 19). Feedback signifiers also include error messages, loading screens (like the 

one present at the application open), animations (like a slide-out animation for the 

Information Panel), and any other means of reducing user uncertainty. 

Accessibility Principles. Building on the prior three principles is the accessibility principle. 

This requires setting design constraints aimed at creating an inclusive product. One way to 

do this is the adhere to the Web Content Accessibility Guidelines (WCAG) published by the 

Web Accessibility Initiative of the World Wide Web Consortium. Some of the constraints 

utilized throughout the production of this application are: 

▪ Conforming to minimum AA-AAA level contrast for graphic and text elements 

▪ Not relying solely on color to imbue meaning, but shape, context, and size as well 

▪ Redundancy of affordances for navigation and interaction design 

▪ Creating the design for a small viewport (iPad Pro 11-inch) that can be scaled up 
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Results 

Project Objectives and Scope 

 The goal of this project was to design a web application that will enable users to 

analyze the cranial morphology of Eunotosaurus africanus how it informs the origination of 

the turtle body plan. Central to executing this goal was creating an accurate cranial 

reconstruction that can contribute to comparative and biomechanical analyses.  

Novel 3D Reconstruction. A novel digital fossil reconstruction of the largest and most 

complete Eunototsaurus skull (M777), both crucial to the didactic goals of the project and 

necessary for finite element analysis (see Discussion), was created in Cinema4D® (Fig. 20-25), 

with a refinement process undertaken in ZBrush®.  

This first stage was conducted using best practices for retrodeformation and 

validated by expert feedback from Dr. Bever and his lab. It filled the missing anatomy via 

extensive mirroring and superimposition of existing elements, as well as restoring the 

silhouette of the skull. In all, the segmented data comprised over 70 bones and bone 

fragments, all of which were repositioned, retrodeformed, superimposed, or mirrored at 

some point in the process. 

2D Reconstructions. Several illustrated skull reconstructions were generated to 

populate the cladogram. For the extinct taxa, they represent novel reconstructions which 

include the braincase and pterygopalatine structures which are often omitted from figures in 

the primary literature (Fig. 26-32).  

User Interface Design. The UI design portion of the project underwent the entirety of 

its first development cycle, culminating in the generation of the following assets: 
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A flowchart (Fig. 33) was created to organize the structural components of the web 

application. Some of the media that comprise this include text, images (.png), animation 

(.mp4), 3D models (.obj), and computed tomography stacks (.tif). 

A series of medium- and high-fidelity wireframes were created as mock-ups of the 

end-user product (Fig. 34-48). For the written content of informational wireframes, see 

Appendix A. 

These prototypes were built using best practices for pedagogic user interface design, 

and their completion marks the first round of development for the application. Throughout 

the process, design principles laid out in the Understanding Evolution project by the 

University of California at Berkeley’s Museum of Paleontology were incorporated for 

optimizing the understanding and retention of macroevolutionary concepts. The small blue 

numbers on the flowchart reflect the image on the storyboard. 

Additionally, the information architecture and overlying design were built to 

accommodate future revisions and additions. 

Didactic Illustrations and Diagrams. Among the assets created to supplement didactic 

text in the user interface were: 

▪ A pedagogically designed phylogenetic tree (Fig. 39-46) 

▪ Supplementary graphic elements, i.e., simplified schematic reptile skulls 

o Figure. Direct comparison between original volume and reconstruction 
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Access to Assets. The products created from this thesis can be viewed at 
www.riverabiovisuals.com, or by contacting the author at agrivera.delrio@gmail.com. The 
author may also be contacted through the Department of Art as Applied to Medicine at 
Johns Hopkins University School of Medicine, https://medicalart.johnshopkins.edu/. 
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Discussion 

On the Final Product 

The Eunotosaurus story concerns an ancient relative that supports justified inferences 

about the origins of the turtle body plan. For one, a life history that is in line with the trend 

towards reduction of the temporal fenestrae, established from the fossorial behavior of early 

turtles. Second, its place as the earliest known stem turtle relative provides insights into the 

order of transformations that resulted in the weird and wonderful creatures we know today. 

To appreciate the former, a novel digital skull reconstruction was generated for this 

application. To implement this model and communicate the importance of the former to 

how turtle evolution is understood, the didactic application “Eunotosaurus: Rethinking Turtle 

Origins” was mocked up.  

Interactive media was chosen to deliver the information for this project because it is 

ideal for communicating biological concepts. It provides an engaging medium to leverage 

best practices for information design, visual storytelling, and managing cognitive load. 

Furthermore, the structural possibilities with web application design allow for the material to 

be updated, expanded, and iterated with ease. Overall, the didactic challenge of this project 

was to accurately and accessibly convey the macro-evolutionary concepts that underpin the 

contribution Eunotosaurus brings to science. 

Importance of Evolution Pedagogy. Evolutionary biology is crucial for helping us 

understand and appreciate the interrelated past, present, and future of life on Earth. 

Moreover, it has wide-reaching consequences for humankind in areas such as health, 

biotechnology, and agriculture (Turcotte et al. 2017; Thrall, 2010; Zimmer, 2010).             For 
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example, evolutionary medicine examines the evolutionary roots of health and sickness. 

Reconstructing the phylogeny of pathogens is crucial to the development of new medicines, 

with coevolutionary pressures contributing to our understanding of public health, infectious 

disease, and chronic illness (Zimmer, 2010). Additionally, any model-based studies done on 

mice, for example, exploit the recent common ancestry we share with them to try and 

extrapolate what physiological processes are conserved between us. In all, a basic 

understanding of how to interpret evolutionary relationships and to use those relationships 

as an analytical framework is needed to prepare a scientifically literate citizenry to tackle the 

world’s problems. 

Part of that preparation involves the teaching of tree-thinking, or the ability to 

evaluate and make inferences about the relationships mapped on an evolutionary tree 

diagram (O’Hara, 1992; Gregory, 2008; McLennan, 2010). A related skill is the ability to 

appreciate how morphological characters inform these relationships (Scotland et al. 2003). 

These skills have significant value in modern science, and yet individuals with even extensive 

post-secondary education can hold lingering misconceptions about how to read and 

interpret these diagrams. Hence the goal is to not only communicate the Eunotosaurus story 

but do so in a manner that bridges these gaps. 

Didactic Content and App Development. The development of the didactic content for 

this project follows best practices for visualizing and teaching phylogenetics. Focus on the 

design of the cladogram, specifically, is validated by the universal importance of 

diagrammatic literacy in the sciences (Novick & Catley, 2012). Schematic diagrams translate 

the structural underpinnings of abstract concepts, making them vital tools for theory 
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development, communication, and problem-solving. Think of how many biological concepts 

are taught through diagrams: food webs, gene maps, family trees, flow charts, and – of 

course – cladograms. Interpreting any diagram, however, relies on learned conventions, as 

their meaning is not always transparent. Pedagogic practice, therefore, strives to intuitively 

map diagrammatic elements with their conceptual meaning (Novick, 2006, June; 

McCullough, 2020). 

This was achieved in a couple of ways. One was through signaling, which draws user 

attention to areas of interest. The cladogram uses color-coding and shape language to 

associate nodes with the groupings they encompass when a user interacts with them. This is 

reinforced using legend icons that tie in these groupings to their descriptions. As a user 

investigates specific characters, their relevance to the cladogram is made visually apparent. 

The skull reconstructions at the terminal nodes recreate the evolutionary transformations 

while keeping their relational context intact.  

The curation of terminal taxa also adds to the didactic messaging by creating a visual 

flow supporting the story of secondary anapsidy in turtles. That is, the change from anapsid, 

to diapsid, and then back to anapsid that characterizes the evolutionary trajectory of turtles. 

Eunotosaurus sits at the center, highlighted as an ‘intermediate’ form between the more 

derived turtles and their diapsid cousins. The format of the tree is a vertical and horizontal 

line grid, which visually reinforces the concept of speciation via divergence, where 

populations of an ancestral species diversify into descendant lineages. This is all achieved 

while avoiding a “ladderized” (or sequential) appearance in the diagram, which not only 
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disrupts erroneous mental models about the progression of evolution but makes it easier for 

viewers to interpret relationships correctly (Novick & Catley, 2012).  

This careful attention to the importance of visual hierarchy and design is per Mayer’s 

Cognitive Theory of Multimedia Learning and Sweller’s Cognitive Load Theory. As important 

as the structure of the diagram and related graphics are to the story being told, the 

accompanying text is also vital to this project’s didactic goals. As such, the text was iterated 

several times for accuracy and clarity by Dr. Bever and other stakeholders. Take, for example, 

the avoidance of characterizing taxa as “basal” and “primitive,” which carry intuitive value 

judgments that can muddle the important takeaways in evolutionary analysis (Bronzati, 

2015). Instead, the goal of the accompanying text is to drive home the distinction between 

“crown” and “stem” groups, which are the crux of all work on evolutionary origins. Any text 

presented in the application is related directly to the visual content, with extraneous 

information available only through links that redirect the user. With added information 

revealed as a user explores, new visuals are generated to accompany them. Doing this 

offloads the cognitive strain of having too much information presented at once.  

As for the novel 3D reconstruction, its inclusion in the application is intended to 

leverage the innate human skills for relating spatially to our environment and handling 

physical objects. While 2D reconstructions are useful for quick and accessible visualizations 

of fossil data, they are limited in how much spatial information they can convey. This can be 

used to favorable effect in diagrams like the cladogram in the Phylogeny section. The 2D 

reconstructions attempt, through shading, to convey information about the midline cranial 

structures (which are often left out of reconstructions in the primary literature, and so had to 
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be generated from extensive research.) This is intentional, as many internal features of the 

skull in Eunotosaurus (prootic-quadrate contact and ossification of orbital cartilage) are 

expressions of its relationship to turtles (Bever et al. 2015, Evers et al. 2020). Instead of 

creating more complexity in the cladogram to demonstrate these cranial features, the 3D 

model was made a core part of the information architecture. 

 Novel Digital Reconstruction. Computer-aided 3D reconstruction of fossils, also called 

virtual paleontology, is well suited for use in public outreach and biocommunication. While 

the display of original fossils in institutions is a cornerstone of scientific outreach, digital 

technologies can reach a wider audience (Ziegler et al. 2020). Furthermore, digital scans and 

reconstructions can reveal previously unknown details of a specimen’s internal and external 

morphology (Conroy & Vannier, 1984; Bever et al. 2015, 2016). Better still, they allow for 

continued research to be done on fossil data without risking damage to fragile materials.  

 In this project, the antemortem state of Eunotosaurus specimen M777 was restored, 

representing the most significant scientific undertaking in this project. It involved intense 

observation of the segmented CT data, reference to a sparse set of primary literature, and 

extrapolation wherever necessary. Given that this was the first reconstruction of its kind, it 

was heavily reliant on existing morphological descriptions of available specimens, 2D 

reconstructions, and feedback from Dr. Bever. The literature in question spanned the works 

of H.G. Seeley (1892), D.M.G. Watson (1914), C.B. Cox (1969), A.W. Keyser (1981), C.E. Gow 

(1981, 1997), Gabriel Bever, and his colleague, Tyler Lyson, (2016, 2016, 2020). Additionally, 

the extrapolation of features that were ill-preserved or extremely deformed came from 

examining the works of E.S. Gaffney (1979, 1990).   
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Future Directions 

Reconstruction. Once the second stage of the reconstruction (cleaning the mesh and 

restoring smooth contours) is done, the model can be uploaded to the application, used in 

articles and animations for outreach, and - most importantly – biomechanical research. The 

last point refers to Finite Element Analysis (FEA) which is a rich avenue to test evolutionary 

hypotheses derived from biomechanical principles and details of skeletal architecture.  

Finite Element Analysis (FEA) is a technique that reconstructs how load-induced 

stresses and strains are distributed within structures. It has been applied in engineering and 

orthopedic medicine, but in recent years has gained major traction in the field of functional 

morphology (Prado et al. 2014). The potential for FEA to engage with questions of 

organismal diversity and form comes from our understanding that changes to the geometry 

and composition of bones can be load-driven (Rayfield, 2001, 2007). The skeleton is a living 

tissue capable of modifying its shape and properties in response to environmental stimuli; 

this is known as bone modeling and remodeling. During the process, bone cells participate in 

the breakdown and formation of bone matrix at sites of low and high loading, respectively. 

The parameters of this load-adaptive regulation (e.g., the threshold at which adaptation 

occurs, the changes to microstructure or mineral content in the bone) are determined by 

genetics, making the bone remodeling process susceptible to evolutionary selection (Krane, 

2005; Christen et al. 2014; Oton-Gonzalez et al. 2022).  

As such, techniques like FEA allow us to explore how and why organisms developed 

their form. In the case of Eunotosaurus, studying load-adaptive remodeling of its skull could 

explain why the supratemporal bone expands to cover the UTF in adulthood. Evidence 
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suggests that it was a fossorial, or burrowing, animal (Joyce, 2004; Lyson et al. 2016). As 

such, it would have used its head and neck to brace its body against the earth while digging 

with its forelimbs. Could the consistent loading of the top of the skull have contributed to the 

expansion of the temporal region and subsequent ‘loss’ of the UTF in its lifetime? Knowing 

that genetically codified life-history changes can have evolutionary implications, could the 

anapsid condition in crown-ward turtles be related to the fossorial ecology of the turtle 

stem? This reconstruction can be used to answer these and other questions.  

For these analyses to work, however, the reconstructions must be as accurate as 

possible. It bears keeping in mind that any reconstruction is subject to an acceptable margin 

for error. Preserved bones and fragments can align in more than one way as a natural 

consequence of their deformations, missing anatomy, or functional plasticity. As such, any 

reconstruction is a hypothesis that reflects interpretations of morphological or functional 

constraints, symmetry, and level of deformation. Still, it is paramount that the work 

undertaken to restore the living shape of a fossil is grounded in as much data as possible. 

Secondarily distorted skulls will provide misleading results and create more problems than 

they solve. This work is the critical first step in the FEA process and thus of great scientific 

importance. 

Application. Future directions for the application include adding the full functionality 

that could not be addressed in this development cycle. Among the tasks remaining are 

mapping out all the potential didactic content, interactions, modules, and animations that 

were alluded to in the current design. Inserting more 3D reconstructions of related taxa are 

also envisioned for this project.  



1 0 4

A p p e n di c e s

A p p e n di x A: Di d a cti c C o nt e nt

F ig u re 4 9 . W ire fra m e # 7 . M or p h ol o g y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

D e sc rip tio n

T h e S u pr at e m p or al b o n e is c o m m o n t o e arl y r e ptil e s a n d is o nl y pr es e nt n o w a d a ys i n li vi n g liz ar ds. It 
oft e n sits i n t h e t e m p or al r e gi o n a nt eri or t o t h e p ost- t e m p or al f e n estr a e.

A n a to m y

It c o nt a cts t h e po s to rb ita l a n d p o s tfro n ta l a nt eri orl y, t h e p a rie ta l m e di all y, a n d t h e s q u a m o s a l a n d 
q u a d ra te i nf eri orl y, a n d t h e ta b u la r p ost eri orl y. 

A d ult E u n ot os a ur us h as a gr a c ef ul, el o n g at e s u pr at e m p or al b o n e t h at c o v ers a h ol e t h at m at c h es t h e 
u p p er t e m p or al f e n e str a e i n ot h er r e ptil es.



1 0 5

F ig u re 5 0 . W ire fra m e # 8 . M or p h ol o g y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

A n c e stra l T ra its (P le sio m o rp h ie s )

-  Pr es e nt
-  C o nt a ct wit h t h e s q u a m o sa l, ta b u la r, a n d p a rie ta l b o n es

R e c e n t T ra its (S y n a p o m o rp h ie s )

U n k n o w n.

U n iq u e T ra its (A u ta p o m o rp h ie s )

-  A nt eri or e x p a nsi o n of t h e e ntir e b o n e i nt o a d ult h o o d



1 0 6

F ig u re 5 1 . W ire fra m e # 9 . M or p h ol o g y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

N a m e o f H o ts p o t S tru c tu re
D es cri pti o n



1 0 7

F ig u re 5 2 . W ire fra m e # 1 0 . M or p h ol o g y t a b. T h e t e xt b el o w c orr e s p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

D e sc rip tio n

E u n ot os a ur us ( L ati n f or st o ut- b a c k e d liz ar d) is a n e xti n ct g e n us of r e ptil es d ati n g b a c k t o t h e Mi d dl e 
P er mi a n. T h e g e n us is r e pr e s e nt e d b y o nl y o n e k n o w n s p e ci es, E u n ot os a ur us afri c a n us. C urr e ntl y, it is 
c o nsi d er e d t h e ol d est t urtl e r el ati v e, a “ tr a nsiti o n al” f or m t h at gi v e s i nsi g ht t o t h e a n c e str al s p e ci e s 
t h at e v e nt u all y g a v e ris e t o m o d er n t urtl e s.

It h as b e e n f o u n d i n t h e K ar o o S u p er gr o u p of S o ut h Afri c a, h a vi n g li v e d i n t h e s w a m ps of t h at r e gi o n 
2 6 0 milli o n y e ars a g o. It w as li k el y a b urr o wi n g, or f oss ori al, a ni m al. T his m a y h a v e c o ntri b ut e d t o t h e 
t urtl e-li k e f e at ur e s it e x hi bits.

It h as h a d a t u m ult u o us hist or y i n s yst e m ati cs as t h e m o d els us e d t o assi g n t urtl e s h a v e s hift e d. Its 
pl a c e m e nt i n t h e t urtl e li n e a g e w as s h a k y fr o m its n a mi n g i n 1 8 9 2 u ntil t h e 2 0 1 0s, w h e n n e w 
dis c o v eri es bri d g e d t h e 5 0 -milli o n y e ar g a p b et w e e n E u n ot os a ur us a n d m or e r e c e nt t urtl e f ossils .

S e e A lso

( Li n k) E u n ot os a ur us T hr o u g h t h e A g e s
( Li n k) T urtl e E c ol o g y: T h e n a n d N o w
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1 0 9

F ig u re 5 3 . W ire fra m e # 1 2 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

Cl a d o gr a ms r e pr es e nt h y p ot h es es a b o ut t h e e v ol uti o n ar y r el ati o ns hi ps a m o n g diff er e nt gr o u ps, or 
t a x a. 

T h e br a n c h l e n gt hs of t his cl a d o gr a m d o N O T:
• C orr el at e wit h t h e p ass a g e of ti m e or dir e ct r el at e d n e ss
• R el at e t o t h e n u m b er of c h a n g es 

T h e s e di a gr a ms s er v e as a fr a m e w or k f or i nf erri n g a n d u n d erst a n di n g p att er ns i n t h e hist or y of lif e o n 
E art h fr o m c h a n g es i n a n at o m y, t o g e n es, t o g e o gr a p hi c al distri b uti o n.

( Li n k) H o w t o R e a d a Cl a d o gr a m



1 1 0

F ig u re 5 4 . W ire fra m e # 1 6 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

N o d e : N e o d ia p sid A n c e sto r

N e o d ia p s id a is t h e cl a d e c o nt ai ni n g t h e cr o w n gr o u p of li vi n g di a psi d r e ptil es ( S a uri a ), t h e 
y o u n gi nif or m e s , a n d t h eir m ost r e c e nt c o m m o n a n c est or (r e pr es e nt e d b y t h e n o d e).

I n t his cl a d o gr a m, t h e t a x o n Y o u n g in a is r e pr e s e nt ati v e of Y o u n gi ni d a e a n d ot h er st e m s a uri a ns , or 
a m ni ot es t h at pr e c e d e d t h e Ar c h os a ur- L e pi d os a ur di v er g e n c e . 

B ra n c h : S a u ria n S te m

T his br a n c h l e a di n g t o t h e di v er g e n c e of t h e N e o d ia p sid s is wit hi n t h e Sa u ria n st e m gr o u p . T h e 
S a uri a n st e m c o m pris e s t h e p ar a p h yl eti c gr o u p of e xti n ct t a x a b et w e e n t h e cr o w n gr o u p S a uri a a n d 
t h e n e xt l ar g e st cr o w n gr o u p, A m ni ot a . 

M ulti pl e e v ol uti o n ar y tr a nsf or m ati o ns o c c urr e d b ef or e t h e di v er g e n c e of N e o di a psi ds, a m o n g t h e m 
ar e (i n n o p arti c ul ar or d er):

• C a ni nif or m t e et h l ost or u n diff er e nti at e d

• L a cri m al t a p ers a nt eri orl y (t h e b e gi n ni n g of a tr e n d)

• I nfr at e m p or al f e n estr a a p pr o a c h e s or c o nfl u e nt wit h c h e e k m ar gi n v e ntr all y

• P ost eri or c or a c oi d l ost



1 1 1

F ig u re 5 5 . W ire fra m e # 1 7 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

N o d e : Sa u ria n A n c e sto r

S a u ria is t h e cr o w n cl a d e of li vi n g di a psi d r e ptil e s a n d t h eir cl os e st e xti n ct r el ati v e s. T h e s e i n cl u d e
P a n- T est u di n es (t urtl e li n e a g e),
P a n- Ar c h os a urs ( cr o c o dil e a n d bir d li n e a g e), a n d P a n- L e pi d os a urs (liz ar d a n d s n a k e li n e a g e). T h e 
n o d e is t h eir m ost r e c e nt c o m m o n a n c e st or .

H er e, t h e S a uri a n o d e cr e at e s a t hr e e- w a y p ol yt o m y , b e c a us e t h er e is n ot y et a n y c o ns e ns us o n t h e 
e x a ct r el ati o ns hi p b et w e e n t h es e gr o u ps.

I n t his cl a d o gr a m, t h e s p e ci m e n S p h e n o d o n is a r e pr es e nt ati v e of cr o w n l e pi d os a urs a n d M es os u c h us
r e pr e s e nts st e m ar c h os a urs.

B ra n c h : S a u ria n S te m

T h e S a u ria n st e m c o m pris es t h e p ar a p h yl eti c gr o u p of e xti n ct t a x a b et w e e n t h e cr o w n gr o u p S a uri a 
a n d t h e n e xt l ar g e st cr o w n gr o u p, A m ni ot a .

M ulti pl e e v ol uti o n ar y tr a nsf or m ati o ns o c c urr e d pri or t o t h e di v er g e n c e of S a uri a ns, a m o n g t h e m ar e 
(i n n o p arti c ul ar or d er):
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• Dorsal origin of temporal muscles 

• External nares close to the midline  

• Absent post-parietal bone 

• Squamosal bone narrow anteriorly, and restricted to the top of the skull 

• Stapes is slender and has an unossified dorsal process 

  



1 1 3

F ig u re 5 6 . W ire fra m e # 1 8 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

N o d e : P a n -T e stu d in e s

P a n -T e stu d in e s is t h e t ot al cl a d e c o m prisi n g all a ni m als m or e cl os el y r el at e d t o cr o w n t urtl e s 
(T est u di n es ) t h a n t o a n y ot h er li vi n g gr o u p. 

Si n c e E u n ot os a ur us afri c a n us is t h e m ost st e m-w ar d t urtl e r el ati v e k n o w n t o d at e, P a n - T e st u di n e s 
c a n als o i nf or m all y b e c all e d t h e cl a d e c o nsisti n g of E u n ot os a ur us a n d all ot h er cr o w n- w ar d t urtl es … 
u ntil a n ol d er st e m t urtl e is f o u n d.

H er e, C h e ly d ra is r e pr es e nt ati v e of cr o w n T e st u di n e s (li vi n g t urtl e s) a n d P ro g a n o c h e ly s r e pr e s e nts t h e 
e xti n ct T e st u di n at e s (t urtl es wit h tr u e s h ells).

B ra n c h : P a n -T e stu d in e s

P a n -T e stu d in e s d es cri b es a t ot al cl a d e, m e a ni n g it is i n cl usi v e of t h e t urtl e cr o w n cl a d e a n d st e m 
li n e a g e. R e c all t h at st e m li n e a g es e xt e n d b a c k t o t h e n e xt l ar g est cr o w n gr o u p, w hi c h i n t his c as e is 
S a uri a .

Wit h E u n ot os a ur us as t h e first d at a p oi nt i n t h e t urtl e li n e a g e, its tr aits t ell us t h at s o m e of t h e 
e arli est c h ar a ct er c h a n g es w er e:

• R e d u c e d n u m b er of d ors al v ert e br a e
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• Wide trunk & expansion of ribs 

• Loss of intercostal musculature 

• Paired gastralia 

• Restricted abdominal muscle insertions to thoracic ribs 

  



1 1 5

F ig u re 5 7 . W ire fra m e # 1 9 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

• U p p er T e m p or al F e n estr a

• L o w er T e m p or al F e n estr a

• J u g al

• Q u a dr at oj u g al

• P ost or bit al

• S q u a m os al

• S u pr at e m p or al

•
Hist ori c all y, t h e m aj or a m ni ot e li n e a g es h a v e b e e n cl assifi e d b y tr aits li k e t e m p or al f e n e str ati o n of 
t h e s k ull. 

H er e, y o u c a n c o m p ar e h o w t h e t e m p or al r e gi o n's b o n es a n d f e n estr a c h a n g e a cr oss t h e e v ol uti o n ar y 
tr e e.

(I n a cti v e Li n k) S e e Tr ait I nf or m ati o n



1 1 6

F ig u re 5 8 . W ire fra m e # 2 2 . P h yl o g e n y t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

T h e t e m p or al f e n estr a e (L ati n : t e m p or al wi n d o ws) ar e bil at er all y s y m m etri c al h ol es i n t h e 

t e m p or al r e gi o n of t h e a m ni ot e s k ull. D e p e n di n g o n li n e a g e, a gi v e n s p e ci es c a n h a v e o n e, t w o, or n o 

t e m p or al f e n estr a e. R es p e cti v el y, t h es e ar e k n o w n as t h e sy n a p sid , d ia p s id , a n d a n a p sid c o n diti o n. 

T e m p or al f e n estr a e us u all y f or m a b o v e a n d/ or b el o w t h e P ost or bit al a n d S q u a m os al b o n es.

It is t h o u g ht t h at t h e s e h ol es ar e ass o ci at e d wit h ris e i n m et a b olis m a n d a n i n cr e as e i n j a w m us cl e 

v ol u m e o v er ti m e. It is li k el y t h at t h es e h ol e s pr o vi d e d m or e s urf a c e ar e a a n d s p a c e f or t h e a d d u ct or 

m us cl e s of t h e j a w t o att a c h a n d l e n gt h e n.

S e e A lso :

( Li n k) A m ni ot es

( Li n k) Di a psi d

( Li n k) A n a psi d

( Li n k) S y n a psi d

( Li n k) E ur y a psi d

( Li n k) Cl as sifi c ati o n



1 1 7

F ig u re 5 9 . W ire fra m e # 2 8 . R e s o ur c es t a b. T h e t e xt b el o w c orr es p o n ds t o t h e ar e a hi g hli g ht e d i n t h e 
y ell o w b o x.

As t h e e arli e st st e m t urtl e t o d at e, E u n ot os a ur us afri c a n us pr o vi d es d at a f or t h e f oll o wi n g i m p ort a nt 

i nf er e n c e s a b o ut t urtl e ori gi ns:

• E xt e n d e d t h e t urtl e li n e a g e b y 5 0 milli o n y e ars f urt h er b a c k t h a n t h e u n dis p ut e d st e m t urtl e 

Pr o g a n o c h el ys , a n d 2 0 milli o n y e ars b e y o n d t h e n e xt ol d e st di a psi d t urtl e a n c est or, 

P a p p o c h el ys ( m e a ni n g “ gr a n df at h er t urtl e. ”)

o S e e : ( Li n k) A m ni ot es A cr oss Ti m e; (Li n k) P ost - Cr a ni al E vi d e n c e

• S u p p orti n g m or p h ol o gi c al e vi d e n c e f or t urtl es h a vi n g di v er g e d fr o m di a psi d a n c est ors.

o S e e : ( Li n k) Alt er n at e H y p ot h es es; ( Li n k) T h e T urtl e Q u e sti o n

• Its u ni q u e lif e hist or y (t h e e x p a nsi o n of t e m p or al b o n es t o r e d u c e/ hi d e t h e U p p er T e m p or al 

F e n e str a e) r ei nf or c es t h e o bs er v e d m e c h a nis ms b y w hi c h l at er t urtl es l ost t h eir t e m p or al 

f e n estr a e a n d b e c a m e a n a psi d.

o S e e : ( Li n k) P h yl o g e n eti c Tr e n ds A m o n g T urtl es

• Usi n g its c h ar a ct eristi cs as d at a p oi nts, t h e a c q uisiti o n of tr aits li k e t h e l oss of i nt er c ost al 

m us cl e s a n d e x p a nsi o n of t h e ri bs c a n b e m a p p e d as v er y e arl y c h a n g e s i n t urtl e e v ol uti o n ar y 

hist or y.

o S e e : ( Li n k) P ost- Cr a ni al E vi d e n c e; ( Li n k) Filli n g O ut t h e T urtl e Tr e e
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• While the traits it has tell us much about what occurred early in the turtle lineage, what is 

lacks says just as much. Eunotosaurus gives evidence to the fact that many turtle traits did 

not arise in tandem with the shell but came about millions of years prior as a series of 

unrelated adaptations, also called exaptations. 

o See: (Link) Turtle Ecology: Then and Now 

In short, Eunotosaurus africanus has set a framework for better understanding the origin of the turtle 

body plan.  
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Appendix B: Existing Resources 

Table 3. Currently available resources for evolutionary biology education. 

Type Name Description 
Web-based 
interactives 
and apps 

NOVA Labs: Evolution  
(https://www.pbs.org/wgbh/nova/labs/) 

Digital interactive puzzle game 
aimed at a lay audience that 
teaches the basics of building 
phylogenetic trees. It includes 
video modules and quizzes for 
use as a teaching aid. Cannot 
save progress without signing 
up. A cladogram is based on 
outdated information. 

 Minute Labs Evolution Simulator 
(https://labs.minutelabs.io/evolution-
simulator/#/s/1/viewer?intro=1) 

Observation game that runs an 
algorithm for population 
dynamics. Users can adjust 
environmental conditions and 
see how they can induce change 
in the population of “blobs” over 
time. Deals with population 
dynamics, drift, and 
microevolution. 

Evolutionary Biology App 
(http://apple.co/1gUK4f5) 

An app made by Brigham Young 
undergraduate students to teach 
basic evolution concepts. Has 
superficial coverage of concepts 
in population dynamics (natural 
selection, genetic drift, and 
other concepts). 

Teaching 
references 

Learn Evolution (UBerkeley) 
(https://evolution.berkeley.edu/) 

An NSF-funded comprehensive 
website on evolution was 
developed for teachers. Provides 
content and resources for K-12 
science teachers. 

Bioquest.org; Bioinformatics Education 
Dissemination: Reaching Out, Connecting, and 
Knitting-together (BEDROCK) 

An NSF-funded bioinformatics 
teaching website with problem-
spaces, or modules, for 
educators to work into lesson 
plans on evolution. 

Websites Evolution: Education and Outreach 
(https://evolution-
outreach.biomedcentral.com/) 

An online journal that posts 
articles for K-16 students, 
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teachers, and scientists to aid in 
evolution pedagogy. 

National Center for Science Education (NCSE) 
Evolution Primers 
(http://ncse.com/evolution/science/evolution-
primers) 

A web page linking multiple 
long-form text articles explaining 
evolutionary concepts. 

HHMI Biointeractive 
(http://www.hhmi.org/biointeractive/evolution-
collection)  

Multimedia library of classroom 
activities, interactives, and short 
films for use in tandem with 
science lesson plans. 

Shape of Life  
Short classroom video series 
introducing multiple 
evolutionary science topics. 

Misconception Monday 
(http://ncse.com/users/stephanie-keep) 

NCSE blog post series regarding 
common evolution 
misconceptions about evolution 
that appear everywhere from 
textbooks to science news 
articles. 

Cranial 
anatomy 
apps 

Head Atlas 
A 3D interactive atlas of 
neuroanatomy, with a fully 
segmented skull, soft tissues, 
and 2500+ labels and 
descriptions. Hotspot labels are 
available to describe individual 
features.  

  



   
 

 

121 

Appendix C: User Personas 

Persona 1/4 
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Persona 2/4 

  



   
 

 

123 

 

 

Persona 3/4 
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Persona 4/4  
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Appendix D: Original Flowchart 
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